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v Introduction
The Mozart-16 sound card is a 16-bit stereo sound card
that supports Sound Blaster ProTM and Microsoft
WindowsTM Sound System standards. The Mozart-16
coordinates all the interfaces on the card to provide CD-
ROM control, audio card function and PC system
support.

The Mozart-16 allows you to run Sound Blaster Pro
compatible games and applications, and the rapidly
growing Microsoft Windows business applications that
are compatible to Microsoft Windows Sound System.

The CD-ROM interface on the Mozart-16 sound card
supports three of the most popular CD-ROM drives in
the market: Sony, Mitsumi and Panasonic.

Features and Specifications

Sound Standards Supported
• Adlib
• Sound Blaster and Sound Blaster Pro
• Microsoft Windows Sound System
• Windows 3.1
• Meets and exceeds Multimedia PC Level 2

Specifications

Wave Audio
• Maximum recording and playback sampling rate of

up to 48Khz stereo
• 16-bit digital-to-analog and 16-bit analog-to-digital

converter
• 16-bit and 8-bit digitizing in stereo and mono mode
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FM Music Synthesizer
• Yamaha OPL3 FM technology music chip using 4

operators
• 16-bit digital-to-analog converter
• Supports two modes:

1) Two-operator mode with 11 voices full stereo
(6 melodies and 5 percussions)

2) Four-operator mode with 20 voices full stereo
(15 melodies and 5 percussions)

Digital/Analog Mixer
• Stereo analog mixing from CD-audio, line-in, FM

music and digitized voice
• Stereo digital mixing from microphone, line-in,

CD-audio and line-out
• Master volume control
• PC Sound Mix
• Balance

Power Requirements
• STD PC Voltages at +5V, +12V
• Current Draw at 1.2A @ +5V, 2A @ +12V

I/O Address
• 220, 240 (Sound Blaster)
• 320-340, (CD-ROM)
• 530, F40 (Windows)
• 388 (AdLib)

Interrupt
• 5, 7 (Sound Blaster)
• 7, 10, 11 (Windows Sound System)

Built-in Stereo Power Amplifier
• 4-watt per channel stereo power amplifier at 4 or

8 ohm
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MIDI Interface/Joystick Port
• Built-in integrated MIDI UART interface with

64-byte FIFO
• IBM PC Joystick/Gameport

CD-ROM Interface
• CD-ROM interface for:

SONY CDU31A and CDU33A
Mitsumi LU005/FX001
Panasonic 562B/563

• CD Audio Connectors

Audio Devices Interfaces
• Speaker out
• Line out
• Line in
• Microphone in

Package Checklist

The Mozart-16 package contains the following items:

• The Mozart-16 sound card
• The Mozart-16 user’s manual
• Three device driver diskettes
• One CD audio cable
• One speaker cable

If any of these items is missing or damaged, please
contact your dealer or sales representative for assistance.
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v Hardware Installation

MozartMozart
OTI601

JP1 JP2

••••

JP9

JP11JP10
J7 J8

J1 J2 J4 J3

Speaker Out

Headphone/
Line-out

Line-in

Mic-inJP7

Game Port/
MIDI In
MIDI Out

The Mozart-16 Sound Card

Connectors
J1: Panasonic CD-ROM Connector
J2: IDE CD-ROM Connector
J3: Sony CD-ROM Connector
J4: Mitsumi CD-ROM Connector
J7: Mitsumi CD Audio-in Connector
J8: PC Buzzer Connector
JP1 and JP2: OPL4 Daughter Card Connectors
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Jumper Settings

Jumper JP7
Microphone Select

On: Electret Condenser
Microphone

(Default)

Off: Dynamic MIcrophone

Jumper JP9
CD-ROM Select

123

1-2 On: Other CD-ROMs
(Default)

123

2-3 On: Mitsumi CD-ROM

Jumpers JP10 and JP11
OPL3/OPL4 Daughter Card Select

On: OPL3 Installed
(Default)

Off: OPL4 Installed

JP10 JP11 JP10 JP11
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Connecting Audio Devices to Audio Jacks

The Mozart-16 sound card is equipped with the follow-
ing input and output connections.

Speaker out
This connector provides 2 channel stereo at a 4 or 6
watts-per-channel output level for a 4 ohm or 8 ohm
external speaker system. No powered amplifiers are
required for 4 ohm or 8 ohm speakers.

Caution:
• Do not plug or unplug the speaker out connections

while playing.
• Do not play at excessive levels.
• Do not plug mono plugs into the speaker output,

otherwise it may damage the amplifier.

Headphone/Line out
Headphones should not be plugged into the speaker
output, otherwise damage to the headphone or excessive
sound pressure level may result. Use 32 ohm, 32mW
stereo headphones. This can be connected to the Line-
in connector of any external amplifier, CD-player, Hi-Fi
set, etc.

Note:
Connecting the headphone will result in the disconnec-
tion of the speaker output. Externally and internally
powered speaker outputs will be muted when head-
phones are connected.

Line-in
This can be connected to the Line-out connector of any
Hi-Fi set, radio set, CD-player, synthesizer, walkman,
etc.
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Mic in
Connect the microphone to the Microphone-in connector
of the sound card.

Game Port/MIDI
The Game/MIDI port is a 15-pin female connector
located just below the Microphone-in connector. This
port can be connected to any IBM PC compatible with
15-pin D-sub connector.

Disable the game port if you already have a game port
or game card installed in your system. This port can be
disabled during software installation.

You need a MIDI adapter to connect a MIDI instrument
to the Mozart-16 sound card. The MIDI adapter can be
purchased at your local computer store and is connected
to the Game/MIDI port.

Connecting a CD-ROM Drive to Mozart-16

1. Switch off your computer’s power.

2. Install the CD-ROM drive into your system. Refer to
your drive’s manual for its installation procedures.

3. Connect the interface cable that comes with your
CD-ROM drive to the appropriate interface connec-
tor on the Mozart-16 sound card.

The Mozart-16 sound card is equipped with four
CD-ROM interface connectors: Mitsumi, Sony,
Panasonic and ATAPI/IDE CD-ROM drive. The
Mitsumi CD-ROM drive interface (J4) is a 40-pin
connector supporting Mitsumi LU005S and Mitsumi
FX001.
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The Sony CD-ROM drive interface (J3) is a 34-pin
connector supporting SONY CDU31A and
CDU33A. The Panasonic CD-ROM drive interface
(J1) is a 40-pin connector supporting models 562B
and 563. The IDE CD-ROM drive interface (J2)
supports all ATAPI/IDE standard CD-ROM drive.

Caution:
Pin 1 of each interface connectors is oriented differ-
ently. Locate pin 1 prior to installing the cable.

4. Connect the power cable to your CD-ROM drive.

5. The Mozart-16 package includes an audio cable as
shown below.

Connect J1 of the audio cable to the Mitsumi Audio-
in connector (J7) on the Mozart-16 sound card. The
other end of the audio cable has three connectors:
J2, J3 and J4. Connect this according to the type of
CD-ROM installed in your system.
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If you are using a Sony CD-ROM (CDU-31 or
CDU-33), connect J2 of the audio cable to the Sony
CD-ROM’s audio-out connector located at the rear
of the drive. Leave J3 and J4 unconnected.

If you are using a Mitsumi CD-ROM (LU-005S or
FX-001), connect J3 of the audio cable to the
Mitsumi CD-ROM’s audio-out connector located at
the rear of the drive. Leave J2 and J4 unconnected.

If you are using a Panasonic CD-ROM, connect J4
of the audio cable to the Panasonic CD-ROM’s
audio-out connector located at the rear of the drive.
Leave J2 and J3 unconnected.

The default setting of the Mozart-16’s CD-ROM
interface is:

CD-ROM type: None
I/O port address: 340H
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v Software Installation
The Mozart-16 sound card includes three program
diskettes. These are the Mozart Installation Diskette,
Mozart Recording Session for Windows and Mozart
Sound Impression for Windows.

Mozart Sound System Installation

The Mozart Installation Diskette contains the
INSTALL.EXE file. This program will copy files and
make necessary changes in your CONFIG.SYS and
AUTOEXEC.BAT files. The CONFIG.SYS and
AUTOEXEC.BAT files are modified to properly initial-
ize the Mozart-16 sound card when the system is
booted.

INSTALL.EXE will also install the necessary Windows
drivers and modify the SYSTEM.INI file. SYSTEM.INI
is modified to set up Windows for Mozart-16 sound
card.

To install:

1. Insert the Mozart Installation Diskette into floppy
drive A or B. At the DOS prompt, type:

A:\INSTALL

2. Follow the instructions on the screen to complete the
installation.
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CD-ROM Driver Installation

Refer to your CD-ROM manual on installing its driver.

Sound Impression Installation

1. Select the Run option under the File menu of the
Program Manager.

2. Insert the Mozart Sound Impression for Windows
diskette into floppy drive A or B. At the DOS
prompt, type:

A:\SETUP

3. Follow the instructions on the screen to complete the
installation.

Recording Session for Windows Installation

Installing from DOS

1. Insert the Mozart Recording Session for Windows
diskette into floppy drive A or B. At the DOS
prompt, type:

A:\INSTALL

2. Follow the instructions on the screen to complete the
installation.
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Installing from Windows

1. Select the Run option under the File menu of the
Program Manager.

2. Insert the Mozart Recording Session for Windows
diskette into floppy drive A or B. At the DOS
prompt, type:

A:\INSTALL

3. Follow the instructions on the screen to complete the
installation.

Midisoft Overview

Recording Session is a powerful sequencer offering
standard MIDI sequencing features, as well as an
editable musical notation display.

The program contains three windows, or views that
you use to record, play, and edit your musical composi-
tions.

Score View
This window displays your music in standard
musical notation. As you record, notes will appear
onscreen. When you play back the song, you can see the
notes highlighted as they are sounding. You can also
add, delete and edit notes and phrases from this window.

Mixer View
This window is where you record, play, name and adjust
tracks. You have real-time control of the playback
characteristics of each track, so you can experiment
before making permanent changes.
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This window also contains the transport buttons similar
to an audio tape deck, as well as a tempo slider, a
Master Volume control, and a song location display
(Counter).

MIDI List View
This window displays your music as MIDI events. If
you are more comfortable with a traditional MIDI
sequencer, this affords you the flexibility of minute
adjustments to the shape of each note. In addition, you
can enter and edit MIDI messages such as Program
Change, Aftertouch, Pitch Bend and others.

MIDI Setup

Before jumping into Recording Session, you need to
make sure that your MIDI interface is set up and in-
stalled correctly.

MIDI interface

Interface type
Recording Session works with any interface supported
by Windows 3.1/Multimedia Windows. You need to set
up the interface with the proper driver in the Windows
Control Panel before it will work with Recording Ses-
sion.

Interrupts
You need to determine something called an interrupt
request level (IRQ) for the interface card. The IBM and
compatible computers use interrupts to signal the CPU
(central processing unit, or brain) of your computer that
a specific part of the system (the MIDI interface in this
case) needs attention. Many items in a PC use interrupts
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hard and floppy disk drives, modems, serial ports,
scanners, mice and other pointing devices, network
adapters, etc.

You must have your interface’s IRQ set to a unique
number, or there will be conflicts. If you do have a
conflict, your MIDI interface will probably not work, or
work intermittently.

Some hints on interrupts:

• Do not use IRQ 4 if you have an active serial port.
• Do not use IRQ 3 (and 4) if you have two serial

ports.
• Do not use IRQ 7 if you use a print spooler.

Otherwise, this is usually a good choice for an
available interrupt.

• If you have a mouse, it is probably set to IRQ 2 or
IRQ 3.

• You normally set the IRQ level with switches or
jumpers on the interface board. Refer to the
manufacturer’s documentation

Port address

Some MIDI interfaces allow you to change their port, or
I/O address. On occasion, another peripheral card, such
as a scanner or SCSI card, may be set to use the same
port address. In this case, you will have to change the
interface or the other peripheral to use a different port
address.
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Installing the MIDI Driver

If you are using Recording Session for the first time,
you need to specify the MIDI driver you would like to
use. You have three choices: Multimedia Drivers,
Midisoft Drivers, and No Drivers.

The Multimedia Drivers option uses generic drivers
written to work with any MIDI program that supports
Windows 3.1/Multimedia Windows. You must have
MIDI properly set up in the Windows Control Panel.
(e.g. you should select General MIDI). Use this option if
you need to use the Windows MIDI Mapper.

The Midisoft Drivers option uses a driver created spe-
cifically for Recording Session. If you use this, you need
to disable any standard MIDI driver settings in the
Windows Control Panel.

The No Drivers option allows you to use the program
for display and editing, but not playback. This is useful
if you have not yet purchased a MIDI interface.
Recording Session should now run, if you have set up
your interface correctly.

A MIDI System

To form a complete MIDI system, you need a MIDI
input device (such as a keyboard) and a MIDI output
device (such as a synthesizer module).

For many years, the word “synthesizer” was connected
with the word “keyboard” in many people’s minds.
Today, synthesizers are recognized to be simply tone-
generating devices which can be controlled by a key-
board, as well as drum pads, motion sensors, breath
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controllers, computer signals, etc. The synthesizer
cannot distinguish between any of these —  it’s all MIDI.

Although many synthesizers (especially older models)
have keyboards attached, there is a growing trend
toward separate components, as guitarists, drummers,
wind players, etc. becoming interested in MIDI. We will
assume for the sake of illustration that you have a
separate keyboard controller and synthesizer module,
even if they are housed in the same case.

The keyboard is the MIDI input device in this case
(substitute guitar controller/drum pads/pitch-to-MIDI
converter etc. if you have those instead). Connect a
MIDI cable from the MIDI OUT jack of the keyboard to
the MIDI IN jack of your MIDI interface. If you do
nothing else, this now enables you to record music,
although you won’t be able to play it back.

The synth module is the MIDI output device in this
case. Connect another MIDI cable from the MIDI OUT
jack of the interface to the MIDI IN jack of the synth
module. You now have a complete system, an input
device (the keyboard) to enter music into Recording
Session, and an output device (the synth module) on
which to play back the finished product.

A relatively new type of synthesizer is one contained on
a sound card that installs inside a computer. These have
the advantage of being compact and economical. Many
of these cards are available with drivers for Windows
3.1/Multimedia Windows.
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Local Control On/Off, MIDI Thru, and MIDI Feedback

Local Control On/Off
When you are using a synthesizer which includes an
integral keyboard, you must use a feature called Local
Control On. This means there is an internal connection
between the keyboard and the synthesizer. If there is no
connection, you would not hear anything when you
pressed a key.

MIDI Thru
A MIDI Thru connector copies any data at the MIDI IN
back out. Many MIDI software packages provide this
same feature, usually called MIDI Thru.

A problem arises when you use a keyboard synthesizer
with Local Control On and a sequencer with MIDI Thru
On. The keyboard sends MIDI messages to both the
synthesizer and the sequencer simultaneously. The
sequencer passes the MIDI messages through and back
to the synthesizer with a slight delay. The result is a
doubling of notes, which is not often useful musically.
To avoid this problem, always use Local Control On (on
your synthesizer) or MIDI Thru (on the sequencer) but
never use both of them together!

MIDI Feedback
A related problem is that many types of MIDI equip-
ment (not only synthesizers) have an internal MIDI Thru
capability. This can be useful in certain situations, but
when hooked into a sequencer that also provides MIDI
Thru, you end up with a classic feedback loop. MIDI
output goes to an input, through to an output, back into
an input, and around the chain, where it starts all over
again. You will either hear garbled or stuck notes, or
everything will lock up and refuse to play.
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Again, the solution is never use MIDI Thru on both the
MIDI equipment and the sequencer simultaneously.
Recording Session allows you to switch the MIDI Thru
feature on or off in the Options menu.
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DOS Utilities

The Mozart-16 sound card provides features for volume
control. These features run automatically during boot-up
since they were installed as part of the installation
program.

Controlling the Master Volume
The MZTVOL.SYS file is the master volume control
program. To release the program from memory, type:

<CTRL><ALT> R

To control the volume, type:

<CTRL><ALT> U to increase the volume.
<CTRL><ALT> D to decrease the volume.
<CTRL><ALT> M to mute the sound.

Controlling the Mixer Panel
The MZTPANEL.EXE file is the mixer panel program.
To release the program from memory, type:

C:\MOZART\MZTPANEL /R

To control the mixer panel, type:

C:\MOZART\MZTPANEL.EXE

To display the mixer panel, type:

<CTRL><ALT> P

Appendix A: Utilities
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To control the volume on both speakers:
• Use the up/down arrow keys to control the volume
• Use the left/right arrows to move from one sound

column to another.

To control the volume of the left speaker:
• Press the left <SHIFT> key
• Use the up/down arrow keys to adjust the volume.

To control the volume of the right speaker:
• Press the right <SHIFT> key
• Use the up/down arrow keys to adjust the volume.

When finished:
• Press <ESC> to quit.

Caution:
Do not use this program under Windows or DOS pro-
grams that use the graphics mode instead of the text
mode display.

Mozart Diagnostic Test

MZTTEST.EXE is a DOS based MOZART diagnostic
program that test the FM synth, wave and line-in data
paths. The test can be run individually or as a group in
single pass or continuous mode. The Mozart-16’s con-
figuration is displayed on the right side of the screen.

Note:
MZTTEST.EXE sets its own volume levels and is not
controlled by the Mozart panel.
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Windows Utilities

Controlling the Volume on the Mixer Panel
Under Windows, go to the MOZART Sound System
window and click the Mozart Mixer icon.

Click on the double control menu box and select the
expanded panel or shrinked panel display. The expanded
panel shows all the sound volume control displays
(master, wave, synth, and line). The shrinked panel
displays the master volume control only. (The master
volume control is the combination of the wave, synth
and line-in sounds).

Use your mouse to control the volume and mixing.

To synchronize the left and right speakers, click the
“Sync” button. “X” will appear in the box. To alternate
the left and right speakers, click the box again and “X”
will disappear.

Switching Modes Under DOS

To switch from Sound Blaster to Windows Sound
System mode or vice versa, use the following syntax:

MZTMODE SB|WSS [/530|/F40]

SB Sound Blaster Mode
WSS Windows Sound System Mode
/530 I/O address 530 (WSS only)
/F40 I/O address F40 (WSS only)
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For Sound Blaster Mode, type:

C:\MOZART\MZTMODE SB

If only SB is specified, the I/O address, interrupt vector
and DMA channel that are used will be based on the
current defaults in the MZTINIT.SYS command line in
the CONFIG.SYS file.

For Windows Sound System, type:

C:\MOZART\MZTMODE WSS [I/O address]

If an I/O address for MZTMODE WSS is not specified,
the I/O address will default to 530.
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